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Cells in living tissues are exposed to substantial mechanical forces and con-
straints imposed by neighboring cells, the extracellular matrix, and external fac-
tors. Mechanical forces and physical confinement can drive various cellular re-
sponses, including changes in gene expression, cell growth, differentiation, and
migration, all of which have important implications in physiological and patho-
logical processes, such as immune cell migration or cancer metastasis. Previous
studies have shown that nuclear deformation induced by 3D confinement pro-
motes cell contractility but can also cause DNA damage and changes in chro-
matin organization, thereby motivating further studies in nuclear mechanobiol-
ogy. In this protocol, we present a custom-developed, easy-to-use, robust, and
low-cost approach to induce precisely defined physical confinement on cells
using agarose pads with micropillars and externally applied weights. We vali-
dated the device by confirming nuclear deformation, changes in nuclear area,
and cell viability after confinement. The device is suitable for short- and long-
term confinement studies and compatible with imaging of both live and fixed
samples, thus presenting a versatile approach to studying the impact of 3D cell
confinement and nuclear deformation on cellular function. This article contains
detailed protocols for the fabrication and use of the confinement device, includ-
ing live cell imaging and labeling of fixed cells for subsequent analysis. These
protocols can be amended for specific applications. © 2023 Wiley Periodicals
LLC.

Basic Protocol 1: Design and fabrication of the confinement device wafer
Basic Protocol 2: Cell confinement assay

Support Protocol 1: Fixation and staining of cells after confinement
Support protocol 2: Live/dead staining of cells during confinement
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INTRODUCTION

Within the human body, cells often experience considerable physical confinement due
to their 3D microenvironment. For instance, endothelial cells navigate through dense
matrices during angiogenesis (Herbert & Stainier, 2011), immune cells migrate through
vascular endothelial barriers and tissues during inflammation and wound healing (Friedl
& Weigelin, 2008; Luster et al., 2005), and cancer cells penetrate interstitial spaces as
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small as 1-2 um in diameter during invasion, intravasation, and extravasation (Weigelin
et al., 2012). Moreover, confinement in the tumor microenvironment promotes increased
metastatic potential and drug resistance in tumor cells (Shen et al., 2021; Tse et al., 2012).
In these processes, cells experience extensive deformations of the cell nucleus (David-
son et al., 2014; Friedl et al., 2011), the largest and stiffest organelle in the cell (Kalukula
et al., 2022). Emerging evidence supports the idea that such nuclear deformation can
modulate various cellular functions, ranging from cell contractility, cytoskeletal organi-
zation, chromatin modifications, and gene expression to cell differentiation and viabil-
ity (Gupta et al., 2012; Hsia et al., 2022; Lomakin et al., 2020; Venturini et al., 2020).
The nucleus is thought to play a central role in cellular mechanosensing, i.e., in trans-
lating mechanical forces and physical confinement into biological responses (Enyedi &
Niethammer, 2016; Kalukula et al., 2022; Kirby & Lammerding, 2018). Nonetheless,
many of the molecular mechanisms linking mechanical inputs to biochemical outputs,
as well as the mechanisms determining how 3D confinement alters cellular morphology
and function of various cell types, remain to be elucidated.

These open questions have motivated the increasing use of either custom-developed or
commercially available devices that provide precisely defined vertical or 3D confinement.
However, many of these devices are unsuitable for long-term cell confinement, which is
needed to accurately assess the biological consequences of confinement. For example,
many devices use PDMS micropillars or glass coverslips to induce cell confinement (le
Berre et al., 2012; Lee et al., 2018; Liu et al., 2015). Because these materials allow only
limited access to the medium and thus limited nutrient availability, they substantially
limit the duration that cells can be confined in vitro. Additionally, these devices often
require the use of costly and bulky hardware such as vacuum pumps, syringe pumps, or
pressurized air. Inconsistent or non-uniform confinement presents further challenges in
existing assays. More recently, some devices have overcome these issues by using agarose
pads to provide nutrient accessibility for long-term cellular confinement (Garcia-Arcos
et al., 2023; Prunet et al., 2020).

Here, we present a simple, easy-to-use confinement device containing agarose pads with
micropillars of a specified height, a 3D-printed weight holder, and simple disk weights
(Fig. 1A, B) to induce 3D confinement of cells to specific heights for up to 24 hr (Fig.
1C). Note that 3D confinement is typically associated with both (1) spatial constraint
resulting from the confinement and (2) mechanical compression, resulting in deformation
of the cell and nucleus. Since the compressive forces may vary over time, whereas the
spatial constraint of confinement remains constant once applied to the cells, we refer to
these devices as confinement devices, not compression devices. To fabricate the device,
photolithography is used to create a pillar array with SU-8 photoresist on a silicon wafer.
The agarose device is then formed by casting agarose onto the silicon wafer containing
the pillar design fabricated to the height of interest. After the agarose device is formed
and individual devices are cut out, it is placed onto cells seeded in a glass dish, and then
the weight holder and weights can be added directly on top of the agarose device to induce
nuclear confinement.

We provide protocols to fabricate the silicon wafer used to form the agarose confinement
devices (Basic Protocol 1) and how to successfully induce and measure cell confinement
with the device (Basic Protocol 2). Additionally, we provide two supplemental protocols
to demonstrate how to fix cells after confinement for further imaging applications (Sup-
port Protocol 1) and how to perform live/dead cell staining and imaging after confine-
ment (Support Protocol 2). This device can effectively induce precisely controlled cell
confinement to elucidate how cells respond to 3D confinement and identify underlying
mechanisms of mechanotransduction.
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Figure1 Overview of agarose confinement device. (A) Cross section (left) and top view (right) schematic of the
confinement device assembly. Assembly includes a 35 mm glass bottomed dish (black), agarose device (blue),
weight holder (red), and weight (gray). (B) Photograph of confinement device assembly. (C) Representative
images of MDA-MB-231 cells with nuclei fluorescently labeled with histone 2B-mNeonGreen under unconfined,
confined to 10 um, or confined to 3 pm conditions. Images are orthogonal views of Z-stacks. Scale bars = 10 pm.

DESIGN AND FABRICATION OF THE CONFINEMENT DEVICE WAFER BASIC

To form the agarose devices with micropillars, agarose is cast onto a mold consisting
of a silicon wafer microfabricated to contain the negatives of the desired device fea-
tures. Since the mold contains features of different heights, it is fabricated using two
layers of photoresist, each corresponding to a specific height. The silicon wafer is fab-
ricated using photolithography techniques, in which the SU-8 photoresist is spun onto
the wafer, exposed to UV light through a photomask containing the design of interest
for each layer, and developed to remove the unexposed photoresist. This process is re-
peated for each layer of photoresist. The final silicon wafer contains two layers of SU-8
photoresist: a lower layer and an upper layer. The lower layer is used to fabricate the mi-
cropillar features, with the height of the layer corresponding to the desired height of
the cells during confinement. The upper layer serves to help remove the agarose de-
vice from the silicon wafer without damaging the micropillars or creating an agarose
lip when cutting out the device that protrudes beyond the micropillars. We recommend
a micropillar height of 2-5 um for confinement and a height of 10-15 um for the con-
trol condition, but the exact dimensions will depend on the height of the cell when
in unconfined 2D conditions, which varies between cell types and culture conditions.
In the following, we provide protocols for the fabrication of devices with micropillar
heights of either 3 um (confinement) or 10 um (unconfined control). One wafer should
be fabricated with a 3 um lower layer, and a separate wafer should be fabricated with a
10 um lower layer. The upper layer contains a 500 pm tall by 3 mm wide circular out-
line of the device to help with removing the agarose from the wafer. This layer will

result in a circular undercut groove in the agarose pad to ensure that when cutting out Elpers et al.
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individual agarose devices, the pillar features are not cut, which would prevent solid con-
tact of the pillars with the substrate during confinement. The upper layer is identical for
both wafers. The protocol assumes basic knowledge of and experience with photolithog-
raphy and wafer fabrication. If needed, please consult with available experts or external
service providers. All fabrication steps should be performed in a cleanroom facility with
proper safety equipment and precautions.

Materials

Piranha etch solution* (3:1 sulfuric acid: 30% hydrogen peroxide)

SU-8 2002 (Kayaku Advanced Materials, cat. no. Y111029 0500L1GL)

SU-8 10 (Kayaku Advanced Materials, cat. no. Y131259 0500L1GL)

SU-8 2150 (Kayaku Advanced Materials, cat. no. Y111077 0500L1GL)

Acetone, semiconductor grade* (Transene, cat. no. UN109)

SU-8 developer* (Kayaku Advanced Materials, cat. no. Y020100 4000L1PE)

Deionized (DI) water

Isopropyl alcohol (IPA), semiconductor grade* (VWR, cat. no. JT9079-05)

Hydrophobic wafer coating* (FOTS (1H,1H,2H,2H-perfluorooctyl trichlorosilane)
deposition or Bosch process to perform sulfur hexafluoride (SF¢) etch with
octafluorocyclobutane (C4Fg) deposition).

AutoCAD software (Tanner L-edit version 2020u7.1, KLayout, or equivalent)

GenlSys BEAMER software (version 6.3.1)

Chrome Photomask, 5 x 5 x 0.90 in, quartz substrate (Telic)

Heidelberg DLW 2000 (Heidelberg Instruments)

Hamatech wafer processor

CZ silicon wafer, 4-in diameter, n-type, 500-550 pum thick* (Nova Wafers)

Oven capable of reaching and maintaining temperature of 90°C

Chemical fume hood compatible with class II photoresist materials

Disposable pipettes* (VWR cat. no. 414004-023)

Resist spin coater

Wafer tweezers (Excelta Corp, model 491-SA-PL)

CleanTips Swabs (Texwipe, TX761)

Cleanroom Amplitude Zeta Wipe (Contec, AMZE0001)

Hotplate with adjustable ramp rate (Fairweather TPS66 or equivalent)

Contact aligner (Karl Suss MA6 or equivalent)

Long pass filter for near UV light (PL-360LP from Omega Optical or equivalent)

Rubylith masking film (Ulano, RU3 151800)

Pyrex Glass dish, 1200 ml, with a diameter larger than the 4-in. wafer (Millipore
Sigma, SKU CLS3140150)

Kapton tape*, 1/8 in. width (ULINE S-14532)

Razor blade* (VWR cat. no. 55411-040)

Profilometer (Tencor P7 profilometer or equivalent)

Oven capable of maintaining temperature of 200°C (YES polyimide bake oven or
equivalent)

Molecular vapor deposition tool (MVD 100 or equivalent) or deep silicon etcher
capable of running the Bosch Process (Unaxis 770 Deep Silicon Etcher or
equivalent)

*Many of these items are general supplies available in cleanroom facilities and
provided by the facility. We have provided catalog numbers when available, but
the specific product available in other cleanroom facilities may vary. We do not
expect this to be an issue. Please consult with your local cleanroom operators if
needed.
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Figure 2 Confinement device photomask design. (A) Lower layer photomask design containing
the array of micropillars to induce confinement and alignment marks for aligning the second layer
photomask to the first layer of photoresist. (B) Upper layer photomask design for the 500-pm layer
and complementary alignment marks. (C) Overlay of the lower- and upper-layer photomask de-
signs. Areas colored in blue and red areas show the pattern that will be exposed to UV-light on
the wafer. SU-8 is a negative photoresist, so exposed photoresist will become insoluble to SU-8
developer, thus forming the intended device design.

Design and generate photomasks, prepare silicon wafers

1. Design the photomask for each layer using the desired features and geometries us-
ing AutoCAD software such as Tanner L-edit (version 2020u7.1) or KLayout. For
complex designs such as ours, which contains multiple circular features, we recom-
mend performing Boolean subtraction using GenlSys BEAMER software (version
6.3.1). In that case, to design the first layer photomask, the array of individual circles
was subtracted from the larger blue circle (Fig. 2A). The photomask designs for the
device used in our applications fit into a 35-mm glass bottom dish, are available on
GitHub (https:// github.com/Lammerding/ Confinement-Device), and can be modi-
fied if desired. Each photomask design includes complementary alignment marks to
align each layer with the previous one on the wafer during exposure. The first layer
photomask will generate alignment marks on the lower layer of photoresist. The
second layer mask will contain alignment marks that will be aligned to the wafer
containing the first layer alignment marks (Fig. 2B, C). After ensuring the tonality
of the digital mask design is correct, convert the mask design to a GDSII file. The
file will then be converted to a DXF file using a conversion program. This is the file
format accepted by the Heidelberg DLW2000 mask writer. Other instruments may
use a different file format.

2. For each layer, print the photomask design on a chrome mask using a mask writer,
such as Heidelberg DLW?2000, following the manufacturer’s instructions.

3. Develop the photomasks and perform a chrome etch using a Hamatech wafer pro-
cessor. Strip the excess photoresist from the photomasks using a resist hot strip bath
and dry the photomasks completely. The final photomasks will be used to expose
the photoresist on the silicon wafer.

The Hamatech wafer processor is a general tool containing a closed and safe environment
that can be used with many photomasks and wafer processes. The photomask will first go
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Table 1 Spin Curves for 3 um Thick Layer with SU-8 2002

Step RMP Acceleration/deceleration (rpm/s) Time (s)
Ramp up 500 100 10
Spin 600 100 10
Ramp down 100 100 10
through a developer process and then a separate chrome etch process. Many cleanrooms
will have standard protocols for these processes.
4. Clean the silicon wafers to be used with a Hamatech wafer processor equipped with

a standard Piranha etch solution. The tool will automatically mix the sulfuric acid
and hydrogen peroxide solutions, ensuring user safety. The tool performs a series of
cleaning and DI water rinsing steps for approximately 8 min.

The Piranha etch solution is used to clean organic material from the wafer and pre-
pare the surface. Alternatively, a Nanostrip solution can be used in a general chemistry
hood. We recommend following your particular cleanroom’s guidelines. When planning
to make multiple identical wafers, for example, to produce multiple confinement devices
at once, it is more efficient to fabricate the wafers in parallel. In that case, each wafer is
processed as described here.

Dehydrate the wafers overnight in a 90°C oven. This is critical before spinning each
layer of SU-8 photoresist. Allow the wafer to cool to room temperature before spin-
ning.

SU-8 fabrication of 3 um lower layer features (use the first wafer for this)

6.

Center the wafer on a spin coater, add 3 ml SU-8 2002 to the center of the wafer,
and run the spin process, selecting settings (Table 1) to produce a 3-um thick SU-8
layer. Remove the photoresist from the outer 5-mm perimeter of the wafer and the
back of the wafer using a cleanroom swab soaked with acetone.

Removing the outer 5 mm of photoresist (the “edgebead”) is common practice to ensure
the wafer does not get stuck in other tools used (i.e., the deep silicon etcher tool). Addi-
tionally, any photoresist on the back of the wafer will come in contact with the surfaces
of the hotplates and can cause the wafer to adhere during baking and leave a residue.

Bake the wafer for 2.5 min on a hotplate pre-heated to 95°C. Remove the wafer from
the hotplate and allow the wafer to cool gradually to room temperature.

If you have access to a cooling block, place the wafer on the cooling block and allow it to
cool for approximately 1 min. Alternatively, you can place the wafer in a wafer carrier,
and it will cool in approximately 3-5 min.

Mount the wafer with the photoresist and the photomask of interest on a contact
aligner tool. The setup will vary depending on the contact aligner used, but in gen-
eral, the wafer is placed with the photoresist side up, and the photomask is placed
on top of the wafer with the chrome side of the photomask facing the photoresist.
During exposure (see next step), the light source will expose the photoresist side of
the wafer through the photo mask.

Expose the photoresist to UV light using a vacuum contact setting. The exact dura-
tion will depend on the light source, the thickness of the photoresist, and the area
of photoresist to be exposed. In our protocol, an exposure time of 15 s produced the
features of the correct size for the 3-um SU-8 layer. A UV light long-pass filter must
be used for SU-8.

It is necessary to perform an exposure array testing multiple exposure times to determine
the correct exposure time. Rubylith can be used to cover portions of the photomask to
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Table 2 Spin Curves for 10 um Thick Layer with SU-8 10

Step

RMP Acceleration/deceleration (rpm/s) Time (s)

Ramp up 500 100 10

Spin

3300 100 33

Ramp down 100 100 35

10.

11.

12.

13.
14.

perform an exposure array on one wafer. Exposure time will depend on the power of the
UV source, so it will vary between contact aligners/steppers and can change over time.
For large features that do not need high resolution, such as the pillars in our design, we
used ‘hard contact mode’ for alignment, which is less precise than ‘vacuum contact mode’
as described in the SUSS MAG6 user manual section “1.4.1 Exposure Programs”. After
exposure and development, inspect the size of the features on the wafer with a microscope
to determine the optimal exposure time.

Remove the wafer from the contact aligner and bake the exposed wafer on a 95°C
hotplate for 3.5 min. Remove the wafer from the hotplate and allow it to cool grad-
ually to room temperature on a cooling block for 1 min.

Add the wafer to a glass dish containing SU-8 developer. Gently swirl the dish for
5 s and remove the wafer from the developer. Rinse the wafer once with DI wa-
ter. Repeat 5-s developer and water rinses until no residue is left on the wafer. For
thin layers, repeated short rinses with developer and DI water are helpful to avoid
overdeveloping the wafer.

Let the wafer dry in a fume hood for at least 4 hr and up to 24 hr. Rinse the wafer
once with isopropyl alcohol (IPA) and DI water. Dry the wafer using a pressurized
nitrogen nozzle.

It is important to use pressurized nitrogen nozzles to dry substrates instead of air because
nitrogen is inert, does not contain water, and nitrogen will not react with water on the
surface of substrates.

Measure the height of the photoresist layer using a profilometer (e.g., Tencor P7).

Dehydrate wafers overnight in a 90°C oven before spinning a second layer of pho-
toresist on the wafer (see step 15 and following).

SU-8 fabrication of 10-um lower layer features (use the second wafer for this)

6.

Center the wafer on a spin coater, add 3 ml SU-8 10 to the center of the wafer and
run the spin process using the settings provided in Table 2 to produce a 10-um thick
photoresist layer. Remove photoresist from the outer 5 mm and back of the wafer
using a cleanroom swab soaked with acetone.

Bake the wafer on a hotplate heated to 95°C for 3.5 min. Remove the wafer from
the hotplate and allow the wafer to cool gradually to room temperature on a cooling
block for 1 min.

Mount the wafer containing photoresist and the photomask of interest on a contact
aligner tool. The setup will vary depending on the contact aligner used, but in gen-
eral, the photomask mask is placed over the wafer containing photoresist, with the
chrome side of the photomask facing the photoresist on the wafer. During the ex-
posure, the light source will expose through the photo mask to the wafer-containing
photoresist.

Expose the photoresist to UV light using a vacuum contact setting. In our protocol,
an exposure time of 17.5 s produced features in the correct size for the 10 um tall
SU-8 layer. A UV light long pass filter must be used for SU-8.

Current Protocols

Elpers et al.

7 of 27

0Q ‘L €T0T ‘66711697

noy/:sdyy woiy papeoy

ASUDIT SUOWWO)) dANEAI)) d[qearjdde ayy £q PauIdA0S a1e SO[O1IE Y() aSN JO SN 10j AIBIqI] duI[uQ) AS[IA\ UO (SUONIPUOD-PUB-SWLID)/W0d Ad[1m ATeIqiourjuo//:sdny) suonipuoy) pue sud I, oy 998 “[$707/L0/y1] uo Areiqry surjuQ Aoqip “Ansioatup) [jouio)) £q L8 12do/z001°01/10p/wod" K[1m AIBIGI[OUI[UO"S|C



Elpers et al.

8 of 27

Table 3 Spin Curves for 500 um Thick Layer with SU-8 2150

Step RMP Acceleration/deceleration (rpm/s) Time (s)
Ramp up 500 100 10
Spin 650 100 60
Ramp down 100 100 15
10. Remove the exposed wafer from the contact aligner and bake the exposed wafer on a

11.

12.

13.

14.

95°C hotplate for 3.5 min. Remove the wafer from the hotplate and allow the wafer
to cool gradually to room temperature on a cooling block for 1 min.

Add the wafer to a glass dish containing SU-8 developer. Gently swirl the dish for
5 s and remove the wafer from the developer. Rinse the wafer once with DI water.
Repeat 5 s developer and water rinses until there is no residue on the wafer. For
thin layers, repeated short rinses with developer and DI water are helpful to avoid
over-developing the wafer.

Let the wafer dry in a fume hood for at least 4 hr and up to 24 hr. Rinse the wafer
once with IPA and then DI water. Dry the wafer using a pressurized nitrogen nozzle.

Measure the height of the photoresist layer using a profilometer (e.g., Tencor P7
Profilometer) to confirm that it matches the desired height of the corresponding fea-
tures.

Dehydrate wafers overnight in a 90°C oven before spinning a second layer of pho-
toresist on the wafer.

SU-8 fabrication of 500 um upper layer features and final processing (apply to both
wafers)

15.

16.

17.

18.

Cover alignment marks on the wafer containing lower layer features using a small
piece of Kapton® tape. This preserves alignment marks during the upper layer spin
process.

Center the wafer on a spin coater, pour 5-7 ml SU-8 2150 on the center of the wafer
and run the spin process. The spin settings for obtaining a S00-um layer are provided
in Table 3. Let the wafer rest for 10 min in the spin coater. Remove the photoresist
from the outer 5 mm and back of the wafer using a cleanroom swab and cleanroom
wipes soaked with acetone.

SU-8 2150 is extremely viscous and must be poured onto the wafer (i.e., it cannot be
pipetted). If the spin is uneven, pour more photoresist onto the center of the wafer and
spin the wafer again. Letting the wafer rest for 10 min after spinning will help create a
layer of even thickness. Be careful to hold the wafer level while removing the outer 5 mm
of photoresist and cleaning the back of the wafer.

Place the wafer on a room temperature hotplate and ramp the temperature to 65°C at
a rate of 1.5°C/min. Hold at 65°C for 30 min, and then ramp to 95°C at 1.5°C/min.
Hold the temperature at 95°C for 16-24 hr, turn off the hotplate, and allow the wafer
to gradually cool to room temperature for approximately 2 hr.

The pre-exposure bake is usually performed at 95°C for SU-8 photoresist. A longer bake
time and more elaborate protocol is needed for the thicker photoresist layer to avoid
cracks or delamination due to thermal stress.

Remove the Kapton tape under the upper layer of the photoresist covering the align-
ment marks on the lower layer of photoresist. This can be done by carefully using
a razor blade to score the edges of the taped area, followed by tweezers to peel the
tape off of the wafer. Use a microscope to confirm the alignment marks are visible
on the wafer.
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19.

20.

21.

22.

23.

24.

Mount the wafer with the photoresist and the photomask of interest on a contact
aligner tool. Align the photomask to the alignment marks on the wafer. Expose the
photoresist for three intervals of 20 s each, with 20 s of rest in between exposures
using a hard contact setting. A UV light long pass filter must be used for SU-8.

Longer exposure times (above 30 s) risk SU-8 cracking and defects, so we recommend
performing multiple shorter exposures to allow the wafer to cool between multiple expo-
sures.

Place the wafer on a room temperature hotplate and ramp the temperature to 95°C
at arate of 1.5°C/min. Hold the temperature at 95°C for 5 min, turn off the hotplate,
and allow the wafer to gradually cool to room temperature for approximately 2 hr.

Add the wafer to the bottom of a glass dish containing ~500 ml SU-8 developer. The
amount of developer can vary but should generously cover the entire wafer. Allow
the wafer to develop for 1 hr, replace it with fresh developer, and allow the wafer to
develop for one additional hour. Rise the wafer with DI water.

If there is still residue on the wafer after rinsing with DI water, place the wafer back into
developer for 5-min periods and perform alternating developer and DI water rinses until
there is no longer residue. You should use a microscope to confirm features on the device
do not contain debris from undeveloped photoresist. For the development process, we
found that including a rotating stir bar in the developer solution can cause delamination
of the photoresist and should be avoided, even if it means that development takes longer.

Let the wafer dry in a fume hood for at least 4 hr and up to 24 hr. Rinse the wafer
once with IPA and then DI water. Dry the wafer using a pressurized nitrogen nozzle.

A long drying step is recommended to allow any remaining solvents to evaporate. These
solvents can otherwise interfere with the next steps of applying the hydrophobic coating
to the wafer.

Perform a hard-bake on the wafer by gradually ramping the oven temperature to
200°C, holding for 1 hr, and then gradually allowing the wafer to cool to 50°C.
Depending on how fast the oven cools, it will take approximately 2 hr to reach 50°C.
Transfer to a wafer holder and allow the wafers to cool to room temperature for
approximately 10 min.

Hard baking increases the thermal stability of the photoresist, and removes any leftover
solvent in the photoresist that could interfere with future etching processes (i.e., the hy-
drophobic coating with C4Fg). Do not open the oven door during the bake while the oven
is above 100°C. This will cause the wafers to shatter. When removing the wafers from the
oven, place them in an upright wafer holder to cool gradually to room temperature. Do
not place the wafers flat directly on a cold metal benchtop.

Apply a hydrophobic coating to the wafer. This can be done using either fluoro-
octyl trichlorosilane (FOTS) deposition with a Molecular Vapor Deposition (MVD)
tool or by running SFg etch and C4Fg deposition (Bosch process) in a Deep Silicon
Etcher. Measure the contact angle on the silicon wafer using a video contact angle
(VCA Optima) system, ensuring a contact angle >95°.

Unlike PDMS, agarose can be cast directly from the silicon wafer, without substantial
wear or delamination. However, if desired, a plastic mold can be generated from a PDMS
cast of the silicon wafer to provide an even more permanent mold that can be used to cast
the agarose devices. We have previously published a detailed protocol for the fabrication
of plastic molds from PDMS casts (Agrawal et al., 2022).

CELL CONFINEMENT ASSAY

This section describes the steps to make the agarose devices, induce confinement of cells
using the devices (Fig. 3), and confirm cell confinement by measuring nuclear cross-
sectional area and nuclear height, which should increase (area) and decrease (height)
under confinement. For biological studies, we recommend comparing cells under three
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different conditions: (1) an unconfined control, (2) confinement with a device sufficient
to induce substantial cellular and nuclear deformation (typically 3-5 um height), and
(3) a control with a device that is taller than the unconfined cell height and thus does
not induce cellular deformation but controls for the presence of the agarose pad and
the squishing of some cells under the micropillars (typically 10-15 pm height). In our
example, we use MDA-MB-231 human breast cancer cells confined to 3 um height, which
is approximately 60% of the original nuclear height of ~5 pum, and a control device with
10-um tall micropillars (Fig. 4A). Different cell types may have different heights and
may tolerate different degrees of confinement.

A
Agarose pad .
z N
Pillar detail
I Confinement height, h
h=2-10 um
0 450 {m > 500 pm 7
‘- v’
Undercut edge of agarose pad = 3000 ym 1500 “ml

2 {3 1o450 um
B Pillar spacing “,_‘, I 5

% 1500 pm

B
Place plastic ring on silicon Pour agarose onto Punch out individual Use individual devices
wafer containing devices devices and let set devices immediately
c Soak agarose \

device in medium

—
> ()

Seed cells one day Image cells prior Place agarose
prior to compression to compression device on cells

o = v
Image cells to confirm Add weight Place weight holder
compression on agarose

Figure 3 Device design and workflow schematic. (A) Schematic depiction of a single agarose device. The
agarose device (light blue) contains an array of micropillars (outlined in black) of a defined height to facilitate
confinement. The second layer of SU-8 provides a region to cut out each individual device without cutting through
the agarose micropillars. Images are not drawn to scale. (B) Preparation of agarose device from silicon wafer. A
plastic ring is placed over the silicon wafer and agarose is poured onto the wafer and allowed to set. Individual
devices are punched out of the agarose and are ready to be used. For simplification, only four devices are
shown on one silicon wafer; however, up to nine devices can be fabricated on one wafer. (C) Cell confinement
and imaging. Cells are seeded ~24 hr prior to the confinement assay. Cells are imaged before confinement.
Immediately prior to use, the agarose device is soaked in media and then immediately placed onto the dish
containing cells. The weight holder is placed on top of the agarose, and the weight is placed onto the holder.
Confinement should occur within 30 min and should be validated via confocal microscopy. This figure uses icons
from Bioicons, an open-source library of science illustrations.
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Figure 4 Confinement device validation. (A) Representative images of MDA-MB-231 cells expressing histone
2B-mNeongreen under unconfined, confined to 10 pm, or confined to 3 pm conditions. Yellow lines indicate the
orthogonal viewpoint. Scale bars = 10 pm. (B) Quantification of nuclear cross-sectional area of unconfined
cells, cells confined to 10 pm, and cells confined to 3 pm. (C) Quantification of nuclear height of cells from
the three conditions. Data is plotted as measurements from individual cells with the mean of each biological
replicate indicated by a black dot. n = 65-162 cells per condition from three independent experiments. **p <

0.01, ****p <0.0001 based on one-way ANOVA with multiple comparisons.

For the experiments, the cells of interest are seeded onto 35-mm glass bottom dishes that
have been coated previously with the appropriate extracellular matrix (e.g., collagen or
fibronectin), using a standard cell culture protocol. After overnight incubation to promote
cell adhesion, the cells are imaged by confocal microscopy to measure nuclear height
prior to confinement. Immediately prior to confinement, the agarose devices are prepared
by casting agarose onto the silicon wafer described in Basic Protocol 1. The individual
devices are cut out and soaked in medium to reduce absorption once they are placed
onto the dish with the cells. To induce confinement, a 3D-printed weight holder is placed
onto the agarose device, followed by the desired amount of weight. For short experiments
inducing confinement for 3-6 hr, 10 g is added to the device. For longer experiments (e.g.,
18-24 hr), the amount of weight is decreased to 5 g to avoid excessive compression. Cells
can be imaged during the experiment to confirm confinement, e.g., based on the changes
in nuclear height and/or cross-section. The nuclear cross-sectional area is expected to
increase upon confinement to 3 pm but should not change when cells are subjected to the
control device with taller micropillars (Fig. 4B). Nuclear height quantification is used to
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confirm even confinement in cells across the entire device (Fig. 4C). This protocol can
be applied to a wide variety of cell types, as it is easy to modulate various parameters
such as the cell confluency and amount of weight used.

Materials

Cells of interest (e.g., MDA-MB-231 human breast cancer cells (ATCC HTB-26)
genetically modified to express H2B mNeonGreen (Allele Biotechnology) or
another nuclear label)

Dulbecco’s Modified Eagle Medium (DMEM) supplemented with fetal bovine
serum (FBS) and penicillin/streptomycin (see recipe)

1x Dulbecco’s phosphate-buffered saline (DPBS), no calcium, no magnesium (see
recipe)

Fibronectin (EMD Millipore Corp, cat. no. FC10-5MG) diluted in 1 x DPBS to
5 ug/ml or type I collagen (Corning, cat. no. 354236) diluted in 0.02 N acetic
acid to 0.05 mg/ml

Trypsin-EDTA, 0.25% with phenol red (Gibco/ThermoFisher, cat. no. 25200-072)

Cell medium suitable for live cell imaging (e.g., see recipe for Fluorobrite or use a
medium compatible with the specific cell type of interest)

Agarose (SeaKem LE Agarose, Lonza, cat. no. 50004, or comparable)

FITC dextran (Invitrogen, cat. no. D7136 or equivalent)

CO; incubator for cell culture (e.g., Thermo Scientific Forma Steri-Cycle)

Water bath set to 37°C

Laminar flow biosafety cabinet (e.g., The Baker Company SterilGARD Class II
Type A2)

35-mm glass-bottom dish (0.17 mm thick) (e.g., FluoroDish, World Precision
Instruments, cat. no. FD35-100)

Cell culture flasks (e.g., 25 cm? flask, Corning, cat. no. 430639)

Inverted bright field microscope

15-ml conical tube (e.g., Corning, cat. no. 352096)

Cell culture centrifuge

Cell counter (e.g., Reichert Bright-Line Hemocytometer or CellDrop Automated
Cell Counter)

Inverted confocal microscope with a 40x immersion objective, motorized stage,
and mounted microscope camera for image acquisition (cells can also be
observed with a 10x or 20x non-immersion objective, but high NA objectives
are needed for accurate nuclear height measurements)

100-mm polystyrene plastic petri dish (e.g., VWR, cat. no. 25384-342) with
bottom removed carefully using an X-Acto knife

17-mm diameter circular metal punch or X-Acto knife

Flat-tipped tweezer (VWR, cat. no. 89259-954)

Kimwipes (Kimtech, cat. no. 34133)

35-mm polystyrene plastic petri dish (e.g., VWR, cat. no. 25384-342)

3D-printed weight holder (printed using an Ultimaker S5 3D printer with
Ultimaker Tough PLA filament, STL files available on GitHub.

Disk weights ranging from 2 g to 10 g with slots (e.g., Amazon)

Microscopy software capable of automated Z-stack capture (e.g., Zeiss Zen Black)

F1JI/Image] or equivalent image-processing software

Extracellular matrix coating and cell seeding
1. Culture cells according to methods appropriate for specific cell lines (Phelan & May,
2017; Picot, 2004). Cells should be cultured in a 37°C incubator with 5% CO,. All
culture media should be warmed to 37°C in a water bath. Work should be performed
in an approved biosafety cabinet. We have demonstrated that this protocol works
consistently with adherent cells; however, due to the ability to modulate experimen-
tal parameters, this device should also be suitable for cells cultured in suspension.
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2.

18-24 hr before the cell confinement assay, coat the glass-bottom dishes with the
appropriate extracellular matrix molecules (e.g., 5 pg/ml fibronectin or 0.05 mg/ml
type I collagen) for 2 hr at 37°C or overnight at 4°C (Agrawal et al., 2022).

The specific choice of extracellular matrix coating will depend on the cell lines used in
the experiments. Fibronectin should be used at a final concentration of 5 ug/ml in 1x
DBPS. Incubate glass dishes with fibronectin for 2 hr at 37°C. Dilute type I collagen in
0.02 N acetic acid to a final concentration of 0.05 mg/ml. Coat glass dishes with collagen
solution and incubate overnight at 4°C. For collagen coatings, it is necessary to wash the
dishes with PBS or cell medium prior to seeding the cells to avoid acidification due to
the acetic acid present in the collagen solution. Seeding cells on glass will likely change
the nuclear and cellular morphology and impact the cellular response to confinement. In
our experience, fibronectin provides a more even coating and consistent nuclear height
compared to a collagen substrate, but this may depend on the specific conditions and cell
lines.

Detach cells using standard cell culture methods. For MDA-MB-231 cells in a T-
25 flask, aspirate the medium and rinse the flask once with 1x DPBS. Add 500 ul
trypsin-EDTA and incubate for 3-5 min until cells are detached. Check that all cells
have detached using an inverted bright field microscope. Add 2 ml culture medium
to neutralize the trypsin and transfer the cell suspension to a conical tube. Rinse flask
three times with 2 ml medium, adding the medium to the conical tube and bringing
the final volume to 10 ml.

Centrifuge detached cells at 300 x g and room temperature for 5 min to pellet the
cells.

Aspirate the supernatant and resuspend the cell pellet in 5 ml medium.
Count the cells using a hemocytometer or an automated cell counting device.

Seed cells onto the coated dishes at a density of 75,000-100,000 cells/dish (corre-
sponding to ca. 37,500-50,000 cells/ml in 2 ml medium).

For optimal confinement, cells should be between 50% to 70% confluence on the day of
the experiment.

Preparing cells for confinement and imaging

8.

10.

Optionally, for cells that do not contain a genetically encoded fluorescent nuclear
label, stain cells with a live cell nuclear/DNA stain (e.g., Hoechst 33342 or SPY555-
DNA) prior to imaging.

For live cell imaging, fluorescent labels or dyes that use longer wavelength for excitation
(e.g., mNeonGreen, mCherry, mScarlet, SPY555, or SPY650) are preferred as they are
less phototoxic than fluorophores requiring shorter wavelengths.

18-24 hr after cell plating, replace the medium with 500 w1 of cell imaging medium
(e.g., Fluorobrite) and place the 35-mm glass-bottom dish on the microscope stage.

Changing the amount of medium will affect the efficiency of confinement, as the agarose
must displace medium to come in contact with the bottom of the dish. If using a dish with
a different surface area, the amount of medium will need to be adjusted.

Acquire multiple fields of Z-stack images using a 40x immersion objective on a
confocal microscope to measure the average nuclear height prior to confinement.
We found that Z-stacks with 0.5-um intervals are typically sufficient. The dish can
be kept on the microscope while the agarose device and weights are added. Alter-
natively, the dish can be removed from the microscope until after step 19, and then
the dish can be placed back onto the microscope to confirm confinement.
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Video 1 Video illustrating steps 11-15 from Basic Protocol 1, which describe how to prepare the
agarose confinement device.

Preparing the agarose confinement device

11.

12.

13.

14.

15.

Prepare a 3% agarose solution by adding 1.5 g agarose to 50 ml of 1x DPBS. Dis-
solve the agarose by microwaving the solution in 15-s intervals for approximately
1 min. Swirl the solution to ensure that all the agarose is dissolved and then let the
solution cool for 2 min.

Typically, a minimum of 50 ml of 3% agarose is prepared. Tissue culture-grade DPBS
is essential to maintain the correct pH of the agarose. If air bubbles form during the
microwaving step, use a vacuum desiccator to evacuate the bubbles. Usually, applying
the vacuum briefly for 10-30 s and then rapidly releasing the vacuum will clear bubbles
from the agarose. A video of steps 11-15 is available (see Video 1).

While the agarose is cooling, prepare the wafer that serves as the mold for the desired
confinement height. Rinse the wafer once with DI water and dry with an air nozzle.
Place the 100-mm plastic ring on top of the wafer to serve as a mold to cast the melted
agarose. This will ensure the thickness of agarose is the same for every casting. The
melted agarose should not leak under the plastic ring due to its high viscosity.

Carefully poor 15 ml of the 3% agarose solution on the wafer. Rotate the wafer
gently, while keeping the 100-mm plastic ring in place to ensure that the agarose is
evenly spread across the wafer. The height of the agarose layer should be approxi-
mately 15 mm. Let the agarose solidify for 10 min.

The agarose devices should be freshly made for each experiment, and used immediately
after preparing. This will ensure the agarose does not dry out before being placed into
the dish with cells.

Carefully remove the 100-mm plastic ring without removing agarose by using tweez-
ers to separate the agarose from the plastic ring. Cut out the individual agarose de-
vices using the 17-mm circular punch or an X-Acto knife, but do not yet remove the
agarose from the silicon wafer.

Remove the surrounding excess agarose using flat-tipped tweezers, leaving the in-
dividual agarose devices on the wafer.
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Video 2 Video illustrating steps 16-19 from Basic Protocol 1, which show the application of the
agarose pad and confinement device. Note that the cell culture medium has been dyed green for
better visualization.

In our experiments, we do not sterilize the agarose, and we do not see any signs of con-
tamination when culturing cells in the device for up to 24 hr (using medium containing
antibiotics and tissue culture-grade PBS). Optionally, the agarose devices can be steril-
ized with UV light, but this should be limited to 10 min or less to minimize the risk of the
devices drying out before use.

Cell confinement

16. Gently lift the edge of the agarose device and pass the flat-tip tweezer under the
agarose without puncturing it. Place the agarose device in a 35-mm dish containing
2 ml cell imaging medium and soak for 1 min.

Soaking the agarose is essential to prevent initial absorption of medium once the agarose
device is placed into the dish with the cells. Flat-tip tweezers are essential for handling
of the agarose devices from this point forward. Pointed tweezers can easily puncture or
tear the agarose. A video of steps 16-19 is available (see Video 2).

17. Using the flat-tip tweezers, gently lift the agarose device out of the dish used to soak
it in medium and place the agarose device on cells in the dish. Wait for ~3 min
to let the dish with the device equilibrate. At this point, the device should not be
compressing the cells. Confocal Z-stacks can be acquired after adding the agarose
device onto the cells to ensure that no confinement is occurring.
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Figure 5 Visualizing agarose micropillars (A) MDA-MB-231 cells expressing Histone 2B-mNeonGreen were
confined to 3 ym or 10 ym, with FITC-labeled dextran added to the cell media to visualize the space between
the agarose, agarose micropillars (red dash line), and the cells and glass dish. Representative images of both
the X-Z and X-Y planes are shown. Yellow lines indicate orthogonal viewpoint. (B) The agarose pillars (red dash
line) can be visualized without dextran in the media to confirm the agarose device is touching the bottom of the
dish. Cells under the pillars will be completely squished and should measure a height of less than 2 pm. Yellow
lines indicate orthogonal viewpoint. Scale bars = 10 ym.

If using 35-mm dishes that contain a circular well with the glass coverslip at the bottom,
ensure that the cell culture medium (500 ul) that had been added to the dish in step 9 is
covering the cells at the bottom of the well, and has not been displaced to the periphery
of the 35-mm dish.

18. Spray the weight holder with 70% ethanol to disinfect it and dry with a Kimwipe.
Gently add the weight holder to the agarose device and let it sit for 3 min. At this
point, cells should not be compressed; this can be verified by acquiring Z-stacks of
the cells, or by assessing a nuclear cross-section.

19. Use the tweezers and carefully add the desired amount of weight onto the weight
holder. For short-term confinement experiments (3-6 hr) we add 10 g onto the device
and confirm that confinement occurs within 30 min. For experiments in which cells
are confined for 18-24 hr, we add 5 g and confirm that confinement occurs within
2 hr of placing the weight onto the device.

The relatively low weight and long time to achieve full confinement helps to minimize
the shear stress associated with displacing the medium between the glass surface and
the agarose pad. Larger weights will result in faster confinement but may also result in
increased fluid shear stress and could lead to excessive compression of the agarose pad,
and thus over-confinement. Particularly for longer experiments (> 18 hr), we found that
although using less weight takes longer to achieve full confinement, it lowers the risk of
over-confinement. We anticipate that depending on the cell type, cell density, and stiff-
ness of the cells, the exact amount of weight added will need to be adjusted. Optionally,
fluorescently labeled dextran can be added to the cell medium to visualize the amount of
medium between the glass dish and agarose, further confirming confinement (Fig. 5A).
For overnight experiments, add 0.5 ml of appropriate cell medium to the outside of the
dish to ensure the cells have adequate nutrient supply.

20. Acquire Z-stacks to measure the height of the nuclei after confinement. We recom-
mend imaging multiple positions to confirm that the confinement height is uniform.
Another quick way to confirm that the micropillars of the agarose device are touch-
ing the glass dish, and thus the device is achieving the desired confinement, is by
looking for areas where the cells are completely squished under the pillars (Fig. 5B).
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In addition, confinement should result in an increased nuclear cross-sectional area
in cells located between the pillars.

Image analysis with Fiji/lmage J

Quantification of nuclear cross-sectional area to confirm confinement

1.

Import Z-stacks of images containing fluorescently labeled nuclei.

If only performing nuclear cross-sectional area measurements, 3D confocal Z-stacks may
not be required, and single sections capturing the mid-plane of the nucleus or wide-field
images of the cell/nucleus may be sufficient. If only using single images instead of 3D
image stacks, skip to step 3.

Select Image > Stacks > Z project. You will be prompted to select the projection
type and the first and last stack. Keep the “start slice” and “stop slice” as they are
and make sure to select “average intensity” for the projection type. Click “OK” to
confirm selections.

If you did not take Z-stacks, you can skip this step.

Select Image > Adjust > Threshold. A Threshold window will open; change the
default filter to ‘Huang’ and select the “dark background” option. Click “Apply” to
apply changes.

If you notice that some nuclei are touching, it may be necessary to apply an additional
filter to split them. In that case, select Process > Binary > Watershed.

Select Analyze > Set measurements. A window will open to check parameters of
interest. Ensure that “Area” is checked.

Select Analyze > Analyze Particles. You will be prompted to set the minimum and
maximum sizes of the particles. For our cells, we set the minimum size at 40 um?
and select “infinity” for the maximum size. Select “Add to Manager” and “Exclude
on edges”. Click “OK” to confirm selections.

A region of interest (ROI) manager window will open and an ROI outlining the
nuclei will appear on the thresholded image. In this window, click “Measure”.

A new window will open with the measurement results. Results are given in units
of um?.

Compare results between cells in unconfined conditions, confinement, and in the
control device. Confinement should result in an increase in nuclear cross-sectional
area (Fig. 4B).

Quantification of nuclear height to confirm confinement
9. Import Z-stacks of images containing fluorescently labeled nuclei. We use the “3D

Objects Counter” plugin to measure nuclear height (Bolte & Cordelieres, 2006).

Nuclear height measurements require confocal Z-stacks acquired with a high resolution,
high NA objective to ensure adequate resolution in the Z-direction. We find that images
acquired with a 40x water immersion objective (NA = 1.2) or a 63X oil immersion
objective (NA = 1.4) work well.

10. Select Analyze > 3D OC Options. You will be prompted to set measurements of

11.

interest. To measure nuclear height, select “Bounding Box”. Click “OK” to confirm
selection.

Select Analyze > 3D Object Counter. You will be prompted to set a threshold to
the image stack. Optionally, you can enter a size filter for objects. Select “Exclude
objects on edges” and under “Maps to show” select “Objects”. This will generate a
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SUPPORT
PROTOCOL 1

new image stack with numbered objects that are measured. Check the “Statistics”
option to export the data with results to a new window in Fiji. When finished, select
“OK” to perform the analysis.

12. The window with the results will open. The dimensions of the bounding box are
listed as “B-width”, “B-height”, and “B-depth” in units of pixels. In this case, “B-
depth” represents the height of the nuclei. Convert the height to micrometers using
the image acquisition parameters.

13. Compare results between cells in unconfined conditions, confinement, and in the
control device. Confinement should result in a decrease in nuclear height (Fig. 4C).

FIXATION AND STAINING OF CELLS AFTER CONFINEMENT

Cell fixation is a common practice used to preserve cellular structure and morphology
for further analysis while reducing the risk of sample degradation. Cell fixation is often
necessary for immunofluorescence (IF) analysis of intracellular proteins or for fluores-
cence labeling using cell impermeable dyes. After fixation, cells are permeabilized to al-
low intracellular labeling and then incubated in blocking solution to reduce non-specific
antibody staining. For immunofluorescence labeling, the fixed sample is then typically
incubated with a primary antibody directed against the protein of interest and then, after
repeated washing to remove unbound primary antibodies, incubated with a secondary
antibody specific to the host species of the primary antibody. In addition, fixed cells can
also be labeled with fluorescent stains labeling specific cellular structures, such as DNA
using DAPI, or F-actin using fluorescently labeled phalloidin. In this protocol, we pro-
vide instructions for the fixation of cells in the confinement devices and for subsequently
staining the cells with phalloidin to visualize F-actin (Fig. 6). The protocol can be readily
adjusted to other applications, and we also include instructions for antibody staining for
IF applications.

Materials

Cell fixation agent (e.g., 4% paraformaldehyde, see recipe)
1x DPBS (see recipe)

Unconfined gy 10 "mlm

3 ums LR

F-actin (Phalloidin) DNA (DAPI)

Figure 6 Validation of cell viability and immunofluorescence staining after confinement assay. MDA-M-231
breast cancer cells were stained with Phalloidin-568 to visualize F-actin (cyan) and DAPI to visualize nuclei
(magenta). Representative images of both the X-Z and X-Y planes are shown. Yellow lines indicate orthogonal
viewpoint. Scale bars = 10 pm.
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0.1% Triton solution (see recipe)

Blocking solution (3% BSA in PBS, see recipe)

Phalloidin Alexa Fluor 568 (ThermoFischer, cat. no. A12380)
Fluorescent dye for DNA (e.g., DAPI, Hoechst)

Chemical fume hood

Brightfield microscope

Benchtop rocking platform shaker (VWR, cat. no. 75832-308 or equivalent)

Flat tip tweezer (e.g., VWR, cat. no. §9259-954)

Inverted fluorescence microscope (with applicable fluorescence
excitation/emission filters) or inverted confocal microscope with 20x objective
or higher with mounted microscope camera for image acquisition (motorized
stage optional, but useful)

Microscopy software for image acquisition (e.g., Zeiss ZEN Black, Zeiss ZEN
Blue)

Protocol steps with step annotations

1.

Follow the confinement protocol described in Basic Protocol 2 and confine cells for
the intended period of time. Depending on the application, we recommend inducing
confinement for 2-24 hr. Alternatively, instead of imaging cells immediately post-
confinement to confirm nuclear height (Basic Protocol 2, step 20), confinement can
be confirmed after cell fixation.

After confining cells for the desired time, gently aspirate the medium from the 35-
mm glass dish without disturbing the agarose device, weight holder, and weights.

In a chemical fume hood, add 1 ml fixation agent and wait 1 hr for fixation to occur.
For our application, we use pre-warmed 4% paraformaldehyde (PFA) for fixation,
which works well for phalloidin and DAPI staining. Other labeling, however, may
require alternative fixation methods such as a methanol or ethanol-based protocol.
The specific fixation method should be selected depending on the cell type used and
application of interest (Hobro & Smith, 2017).

Carefully remove fixative and replace with 1 ml PBS. Gently lift the weight holder
and weight off the agarose device. Using tweezers, carefully peel the agarose device
off the fixed cells. Wash cells twice with 1.0 ml DPBS for 5 min.

After the initial fixation, the confined cell morphology should be preserved, even after
removing the agarose pad. Sufficient fixation is required to ensure that cells retain their
morphology and do not detach from the glass bottom when the agarose device is removed.

Examine cells using a brightfield microscope. You should be able see the circular
areas where the micropillars were, as the squished cells under the micropillars are
typically peeled off together with the agarose device. Cells confined to 3 pm will
appear to be flatter and have greater cross-sectional areas than unconfined cells or
those confined to 10 um.

At this point, samples can be stored in DPBS at 4°C until staining, or you can proceed
with the staining protocol. For longer term storage, add sodium azide to the DPBS (0.02%
w/v) to prevent microbial contamination. Note that for some sensitive applications (e.g.,
analyzing protein phosphorylation), cells should be stained and imaged as soon as pos-
sible.

. Permeabilize cells using 0.1% Triton at room temperature for 15 min. Wash cells

twice at room temperature with 1.0 ml PBS for 5 min.

Aspirate PBS and add 1 ml blocking solution to the dish. Incubate for 1 hr on a
benchtop rocking platform set to low speed at room temperature.

Current Protocols
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8. For phalloidin staining: add 250 pl of 1:200 Phalloidin-568 in PBS. Incubate with
rocking at room temperature for 1 hr. For immunofluorescence labeling: add 250 ul
primary antibody to the dish and incubate at 4°C overnight on a benchtop rocking
platform.

For immunofluorescence labeling, primary antibody concentrations typically range from
1:100-1:500 in PBS containing 3% BSA. The exact concentrations will depend on the
antibody and protein of interest and should be optimized for each new target. For some
antibodies, incubation at 4°C for a longer period may be preferable. Secondary antibody-
only controls should be used to address nonspecific binding. For phalloidin staining, skip
steps 10 and 11 and resume at step 12. Phalloidin-568 is a fluorescent stain already con-
Jjugated to a fluorophore, so no secondary antibody is needed. Phalloidin is also available
with many other fluorescence labels.

9. Aspirate antibody or staining solution. Wash twice with PBS for 5 min on a rocking
platform.

10. For immunofluorescence labeling: incubate samples on benchtop rocking platform
for 1 hr with secondary antibody solution compatible with the primary antibody
used. We recommend a secondary antibody concentration of 1:250 diluted in PBS
containing 3% BSA, but the specific concentration will depend on the particular
antibodies used.

11. Aspirate solution. Wash twice with PBS for 5 min on a rocking platform at room
temperature.

12. Stain with DAPI at a dilution of 1:500 in PBS for 30 min at room temperature on
a rocking platform. Wash twice with DPBS for 5 min and store in 0.5 ml DPBS at
4°C.

DAPI is a versatile, robust, and bright nuclear stain that binds to DNA. Alternatively,

Hoechst or other DNA intercalating dyes can be used. The concentration of the dye should
be optimized for each application.

13. The fixed and stained cells can be temporarily stored at 4°C or imaged right away on
a microscope. For longer term storage, sodium azide should be added to the DPBS
solution (0.02% final concentration). Images of the stained cells can be acquired on
a confocal or wide-field fluorescence microscope, depending on the specific appli-
cation. We recommend acquiring high resolution Z-stacks on a confocal microscope
to confirm the confined morphology of the cells.

LIVE/DEAD STAINING OF CELLS DURING CONFINEMENT

Staining living cells, combined with time-lapse microscopy and multiposition settings,
can be used to assess dynamic effects of 3D confinement, and allows the comparison of
the same cells pre- and post-confinement, thereby reducing cell-to-cell variability. Ad-
ditionally, live/dead cell staining is useful to ensure cell viability at the end of various
assays. Here, we present a basic protocol for live/dead staining of MDA-MB-231 cells
with propidium iodide after 24 hr of 3-um height confinement, 10-um height confinement
(control), and in unconfined cells. Our results demonstrate that cells remain viable even
under prolonged confinement at 3 um, with only cells that were located under the agarose
micropillars and thus were squished completely staining positive for propidium iodide
(Fig. 7). This protocol can also be applied to other live cell stains, as we show that the
cell stain diffuses throughout the confinement device within 1 hr of adding the staining
reagent.

Materials

All materials from Basic Protocol 2
Live/dead cell stain of interest (e.g., propidium iodide, which labels dead cells,
used at 1 pg/ml in cell culture medium)
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H2B-mNeonGreen Propidium lodide

Protocol steps

. Follow the confinement protocol described in Basic Protocol 2 to apply confinement.

For live cell imaging of cells starting before confinement is applied, the desired cell stain
of interest can be applied to the cells prior to applying the confinement device. In that
case, it is important to avoid moving the dish with the cells when applying the device, or
carefully repositioning it after applying the confinement device to capture the same cells
again. Note that prolonged incubation of cells in medium containing propidium iodide can
result in false positive labeling, as even live cells may take up the dye over time. Thus, for
lived/dead staining with propidium iodide, we recommend applying the propidium iodide
only at the end, as described here.

. Afterincubating confined cells for the desired amount of time, gently aspirate medium
from the edge of the dish, make sure not to move the confinement device.

. Add 1 ml cell culture medium containing the stain of interest to the dish, just outside
of the confinement device. For our live/dead stain application, we used 1 pug/ml of
propidium iodide in Fluorobrite medium.

It is essential to keep the weight holder and weight on the agarose device during staining
to ensure the agarose does not detach from the substrate and shear the cells.

. Incubate the dishes at 37°C for 1 hr. We found that diffusion of stain across the cells
in the device consistently occurs by 1 hr.

If performing experiments at room temperature (which is suitable for many cell types),
it may be necessary to extend the incubation time to ensure that propidium iodide has
diffused completely in all areas below the agarose device.

. Gently aspirate the medium from outside of the device. For live cell imaging, e.g.,
to quantify the fraction of cells positive for propidium iodide, add 1 ml cell imaging
medium to the dish. The cells can then be imagined on a fluorescence microscope or
maintained in culture. Alternatively, if using a live-cell stain compatible with fixation,
the cells in the device can be fixed and stained using Support Protocol 1.

REAGENTS AND SOLUTIONS
Blocking solution

1.5 g bovine serum albumin (Sigma Aldrich, cat. no. A7906)
50 ml 1x PBS

Current Protocols

Figure 7 Live/dead staining after 24 hr of confinement. MDA-MB-231 breast cancer cells expressing Histone
2B-mNeonGreen remain viable after 24 hr in the device under unconfined, 10 um confinement, and 3 pm
confinement conditions. Cells completely squished under the agarose pillars (red) stain positive after incubation
with propidium iodide. Scale bars = 100 pm.
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Vortex for 30 s and rock on benchtop rocking platform until BSA dissolves.
Store at 4°C for up to 2 weeks.

Cell culture medium (prepare in sterile environment)

445.0 ml Dulbecco’s Modified Eagle Medium (DMEM) (Gibco/ThermoFisher, cat.
no. 11965092)

50.0 ml Fetal Bovine Serum (Avantar by VWR, cat. no 89510-186)

5.0 ml Penicillin/Streptavidin (Gibco/ThermoFisher cat. no. 15070-063)

Store at 4°C for up to 4-6 weeks.

DPBS, 1x (tissue culture grade, prepare in sterile environment))

5.0 ml 10x DPBS (Gibco/ThermoFisher cat. no. 14-200-075)
45.0 ml autoclaved DI water
Store at 4°C for up to 1 month.

Fluorobrite medium (prepare in sterile environment)

42.5 ml Fluorobrite Dulbecco’s Modified Eagle Medium (Gibco/ThermoFisher,
cat. no. A1896701)

1.5 ml 1M HEPES for imaging without 5% CO, (Gibco/ThermoFisher, cat. no.
15630080)

0.5 ml 100x GlutaMAX (Gibco/ThermoFisher, cat. no. 35050061)

5.0 ml Fetal Bovine Serum (Avantar by VWR, cat. no. 89510-186)

0.5 ml Penicillin/Streptavidin (Gibco/ThermoFisher cat. no. 15070-063)

Store at 4°C for up to 4-6 weeks.

PBS, 1x (non-tissue culture grade)

900 ml DI water
100 ml 10x PBS (see above)
Store at room temperature for up to 2 months.

PBS, 10x (non-tissue culture grade)

1.4 g/L Potassium dihydrogen phosphate (KH,PO,)

90 g/L. Sodium chloride (NaCl)

7.9 g/L. di-Sodium hydrogen phosphate anhydrous (Na,HPO, 7H,0)
1.0 L DI water, adjust to pH 7.4

Store at room temperature for up to 6 months.

PFA, 4%

4.0 g paraformaldehyde (Sigma, SKU 158127-500G)
100 ml warm PBS
Store at 4°C for up to 2 weeks, or frozen at —20°C for up to 6 months.

Triton, 0.1%

0.5 ml Triton X100 stock (Sigma, SKU X100-500ML)
49.5 ml 1x PBS (see recipe above)
Store at room temperature for up to 6 months.

COMMENTARY

Background Information now generally categorized as ‘mechanobiol-
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Researchers have long studied the effect
of mechanical forces and the physical envi-
ronment on cells, as it is well recognized
that these factors can substantially modulate
cellular fate and function. This research is

ogy’. In recent years, an increasing interest
has fallen on the cell nucleus, and nuclear
mechanobiology has gained the spotlight as a
promising avenue to elucidate the molecular
mechanisms surrounding various diseases and
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physiological processes, ranging from cancer
metastasis to immune cell function and muscle
diseases. Although various cell confinement
systems have been developed over the past 15
years, many of the systems come with their
own challenges and limitations, particularly
when applying prolonged confinement. To ad-
dress these challenges, and after having tested
numerous confinement systems in our labora-
tory, we have developed a robust confinement
assay that can be easily tailored to specific ap-
plications due to its simple design. While ulti-
mately in vivo assays are still needed to fully
recapitulate the 3D biological microenviron-
ment of cells, the system presented here pro-
vides a cost effective, reliable in vitro assay to
probe consequences of cell confinement and
nuclear deformation with precise control over
the degree of confinement. The main advan-
tage of this device is the simple concept of
adding weight to the agarose micropillars to
induce cell confinement. This device does not
require costly external hardware, specially de-
signed microscope stages, or other machined
parts. Although the cost and time consider-
ation to fabricate the silicon wafer must be
considered, the relatively low one-time costs
should not exceed a few hundred dollars and
can be outsourced to commercial or academic
service providers if necessary.

Critical Parameters

Fabrication of the silicon wafer
During the fabrication of the silicon wafer,

it is essential to precisely follow the protocol
in the critical steps listed below, as small vari-
ations can result in highly variable outcomes
or unusable wafers. For the lower layer SU-
8 features, baking steps should be timed pre-
cisely, while the pre- and post-exposure bake
times are more flexible for the upper layer SU-
8 features. It is essential to always let the wafer
cool to room temperature after baking before
starting the next step. When exposing the sili-
con wafer, always take note of the UV source
power and adjust the exposure time propor-
tional to the change in lamp power if needed.
The hard bake step is critical to ensure that up-
per layer features do not delaminate after mul-
tiple casts of agarose from the silicon wafer.
As with any other baking step, let the silicon
wafer cool gradually to room temperature.

Cell seeding

Proper cell seeding density is essential
to ensure consistent results using the same
amount of weight, as a larger number of cells

Current Protocols

will offer more resistance to confinement. Al-
though more weight can be added if the cells
are seeded at a high density to ensure con-
finement, we found that this approach often
leads to overconfinement, likely due to col-
lapse of the micropillars under the weight.
Similarly, if the cell density is lower than
expected, overconfinement can occur if the
standard weight is applied. In our experi-
ence, dishes with 50% to 70% cell conflu-
ency work best to achieve uniform and ro-
bust confinement even for extended periods of
time.

Preparing the agarose confinement device

Prior to preparing the agarose devices, rinse
the silicon wafer once with DI water to en-
sure that no dust or other agarose is left on
the wafer. Completely dry the wafer before
casting the agarose. Since agarose is a hydro-
gel that contains a large volume fraction of
liquid, it is important to dissolve the agarose
in tissue culture-grade DPBS to ensure that
the pH in the cell culture medium does not
change when the device is applied to the cells.
If the agarose is dissolved in PBS outside the
pH range of 7-7.3, the amount of medium the
agarose device absorbs once placed onto the
cells will be affected and can negatively im-
pact the cells and cause cell death. Conversely,
dissolving the agarose in water will cause os-
motic swelling of the cells once the agarose
device is placed into the dish. We highly rec-
ommend preparing fresh agarose for each ex-
periment. While handling the agarose devices,
it is essential to use flat-tip tweezers and gen-
tle handling to avoid puncturing the agarose.
We recommend preparing the agarose devices
immediately prior to the confinement assay
to ensure that the agarose devices do not dry
out.

Cell confinement and imaging

It is essential to soak the agarose device in
medium for 1 min prior to the assay. Under-
soaking the device risks the agarose absorb-
ing too much medium when placed in the dish,
which can result in overconfining the cells. Af-
ter starting the cell confinement, avoid mov-
ing the dishes too often, as this can cause the
weight holder and weight to slide around and
either (1) induce non-uniform confinement if
the weight is not distributed evenly, or (2)
cause the agarose to slide and shear the cells.
When imaging the cells, be sure to avoid satu-
ration of fluorescent markers, as this can affect
the height and cross-sectional area measure-
ments of the nuclei.
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Table 4 Troubleshooting Guide for Cell Confinement

Problem Possible cause Solution

Immediate The agarose is absorbing the cell Soak the agarose for a longer time or reduce its
overconfinement and cell medium due to inefficient thickness by using 10 ml agarose solution
death after adding the soaking of the agarose device or instead of 15 ml.

agarose device, before altered pH of agarose. Ensure the pH of the PBS used to make the
adding weights agarose is ~7.1 or the same pH as the cell

No confinement occurs

Overconfinement

Cells are too confluent.

Agarose micropillars were
damaged when cutting or
handling the device causing
displacement of agarose and
interfering with the device being
able to evenly touch the dish.

Not enough weight was applied.

Not enough time has passed for
confinement to occur.

Cells are not confluent enough.

Too much weight is applied.

culture medium.

Reduce the number of cells when seeding to get
a 50% confluency.

Recast agarose and carefully cut out new
devices. Be sure to use flat tweezers and do not
forcefully clamp down on the agarose device
with tweezers.

Add more weight to the device. We recommend
adding weight in 5 to 10 gram increments.

Robust confinement should occur within 30
min. If this is not the case, incubate cells for 30
more min, check nuclear height, and proceed to
try and add additional weight.

Increase the cell density until 50% to 70%
confluency is obtained.

Reduce the amount of weight added to the
device.

Elpers et al.
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Cell fixation

It is essential to keep the agarose firmly in
contact with the bottom of the dish during fix-
ation by keeping the weight and weight holder
in place during incubation. If the weight and
weight holder are removed prematurely, the
agarose can detach and shear cells off the dish.

Troubleshooting

Table 4 includes a troubleshooting guide
for issues that can occur. We have included
probable causes of the issues observed, along
with solutions we found helpful to address
common problems.

Understanding Results

The confinement of cells can be confirmed
by acquiring Z-stack images and measuring
nuclear height (Fig. 1C). Confined nuclei typ-
ically appear flat in the X-Z view as shown
in the representative images, while unconfined
nuclei will appear more rounded in the X-Z
view. Given the limited resolution in the Z-
axis, even when using high NA objectives, we
typically allow for 0.5 pm of error when mea-
suring nuclear height (i.e., nuclei confined to
3 pum should measure 2.5-3.5 pum in height),
and this could vary further depending on the
imaging parameters set. We recommend us-
ing the same imaging parameters across ex-

periments to achieve consistent measurements
of nuclear height. Cells confined to 3-pm mi-
cropillars should also exhibit an increase in
nuclear cross-sectional area (Fig. 4B) as their
nuclear height decreases (Fig. 4C) when com-
pared to cells confined to 10-um pillars or in
unconfined conditions. For the MDA-MB-231
cells used in our example, the nuclei mea-
sured ~7 pm high on average when grown
in unconfined conditions. Thus, confinement
to 10 um does not affect nuclear height or
cross-sectional area compared to unconfined
cells, whereas confinement to 3 um decreases
nuclear height and increases nuclear cross-
sectional area. Additionally, we demonstrate
that confinement of MDA-MB-231 cells be-
low 5 um induces nuclear envelope rupture
(Video 3), as reported elsewhere (Denais et al.,
2016; Nader et al., 2021; Shah et al., 2021).
Consequently, the confinement device can be
used to induce nuclear envelope rupture and
study the downstream consequences such as
induction of DNA damage and activation of
DNA damage response pathways.

For initial validation of achieving uniform
confinement across the device, we recom-
mend adding fluorescently labeled dextran
to the medium before applying confinement.
When combined with 3D confocal imaging,
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Video3 MDA-MB-231 cells expressing NLS-GFP and stained with Hoechst 33342 to label DNA
experiencing nuclear envelope rupture after confinement to 3 pm tall. Nuclear envelope rupture
is detectable by rapid leakage of the NLS-GFP from the nucleus into the cytoplasm. Scale bar =

10 pym.

one can visualize the space occupied by the
medium between the glass bottom/cells and
the agarose pad (Fig. 5A). This approach
is particularly useful to ensure the agarose
micropillars are touching the glass dish, and
the apical cell surface is in contact with the
agarose when applying severe confinement.
Contact of the micropillars with the glass dish
can also be confirmed without using dextran
by looking for circular patches of completely
squished cells under the agarose micropillars
(Fig. 5B). Cells on the edge of the micropil-
lars will be easily distinguished using the
orthogonal view as they will show an apparent
change in height at the location of the pillar.
Fluorescent labeling or immunofluores-
cence of cellular structures should demon-
strate clear effects in conditions where the ver-
tical confinement is lower than the height of
unconfined cells. The exact results will depend
on the application. In our example, we stained
MDA-MB-231 cells with phalloidin and DAPI
to visualize F-actin and DNA, respectively
(Fig. 6). Because the nuclei are fixed under
the device during confinement for immunos-
taining applications, the nuclear height should
not change compared to before fixation, and
you should confirm that cells of interest are
confined to the desired height. Our propidium
iodide staining shows that cells remain viable
even after 24 hr of confinement (Fig. 7). If cell
viability is reduced substantially during or af-
ter confinement, the cells were likely overcon-
fined or the pH or osmolarity of the solution
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changed due to the addition of the device (see
Troubleshooting tips).

Time Considerations

Design and fabrication of confinement
device wafer

The design of the photomask takes 2 to 4 hr.
More complex designs may take much longer.
Writing and developing the photomask will
take 3 to 4 hr. Piranha cleaning one silicon
wafer takes 5 to 8 min, and the wafer must be
dehydrated overnight before use. Lower layer
feature fabrication (3 pm or 10 um micropil-
lar layer) will take approximately 2 to 4 hr.
The 500-um upper layer takes approximately
36 to 48 hr due to the long bake times. The
final hard bake of the silicon wafer and hy-
drophobic coating will take approximately 4
hr. From start to finish, fabrication of one com-
plete wafer will take about 1 week for an ex-
perienced user. However, troubleshooting and
re-optimization of parameters such as the spin
recipe, exposure time, bake time, and devel-
oper time may require additional time.

Cell confinement and imaging

Coating the 35-mm glass dishes takes 3-
5 min. Passaging and seeding cells takes ap-
proximately 30 min. This must be done one
day prior to the confinement assay. Prepa-
ration of the agarose devices will take 15-
20 min. For each experiment, it takes approx-
imately 20 min from the time of soaking the
agarose in medium to the time of adding the
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weight and letting the device reach confine-
ment height after 10 min. For live cell imag-
ing experiments, image acquisition time will
depend on the parameters chosen. We recom-
mend a confinement time of at least 1 hr, but
this depends on the intended application. Cell
confinement can be maintained for 24 hr or
longer. For longer confinement periods, we
recommend confirming cell viability using ap-
propriate live/dead cell stains, and potentially
replacing the medium every 24 hr.

Immunostaining after confinement

Once the confinement is applied for the de-
sired time, washing with PBS and PFA fixation
takes approximately 1 hr. Depending on the in-
tended immunostaining application, staining,
and washing times may vary, but we recom-
mend overnight incubation at 4°C for the pri-
mary antibody and 1 hr incubation at room
temperature for the secondary antibody. Phal-
loidin and DAPI staining takes approximately
2 hr to complete after fixation.

Live cell staining during confinement

After the addition of a live/dead cell stain,
we found that diffusion under the agarose de-
vice can take up to 1 hr to ensure uniform la-
beling. Optionally, the cells may be washed
with medium for an additional hour.
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